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MANDOS DE RESPUESTA 

1.- ¿Qué es un Sistema de Mandos de Respuesta? 
 

Los Sistemas de Mandos de Respuesta permiten realizar preguntas colectivas a una audiencia y recoger 
las respuestas individuales emitidas mediante mandos electrónicos. 

2.- ¿Qué beneficios aporta? 
 

Fundamentalmente los beneficios contrastados de la utilización de estos sistemas son: 
 
- Fomentar la Participación Incrementar el Nivel de Atención 
- Potenciar la Retención 
- Facilitar información al instructor o ponente 

3.- Componentes de un Sistema de Mandos de Respuesta: 
 

Los componentes esenciales son: 
 
- Un Software que se instala en el PC 
- una Base Emisor-Receptor que se conecta a éste 
- tantos Mandos de Respuesta Interactiva como participantes. 

4.- Funcionamiento: 

1. El software permite definir preguntas o cuestiones incluyendo textos, imágenes, vídeo, audio 
etc.. 

2. El ponente activa el inicio de las preguntas 
3. Los participantes responden pulsando en su mando la tecla que corresponde a su respuesta 
4. Las respuestas son registradas en el ordenador, y opcionalmente visualizadas en un gráfico 
5. Un conjunto de informes permiten explotar la información registrada 
6. La información es exportable a Excel 

5.- Tecnologías disponibles: 
 

En función de la tecnología de comunicación inalámbrica bidireccional entre la Base Emisor-Receptor y 
los Mandos de Respuesta los Sistemas se clasifican en Infrarrojos o de Radiofrecuencia.  

6.- Catálogo y Fichas técnicas: 
 

Consulte la información detallada y fichas técnicas de los Sistemas de Mandos Infrarrojos y de 
Radiofrecuencia 

Referencia:  http://www.educlic.es/mandos.html 
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ANTECEDENTES 

Diversos estudios sobre los métodos utilizados habituales de enseñanza indican que: 

El material utilizado es generalmente aburrido y no llega a captar la atención de los estudiantes. Cuando 
se utilizan medios audiovisuales con frecuencia se producen interrupciones y pérdida de tiempo. 

El tiempo que se dispone para cada sesión suele ser insuficiente para el tema a desarrollar, 
especialmente si el instructor anima a los estudiantes a intervenir con preguntas y comentarios. 

La atención y el interés de los estudiantes decrece durante una explicación en la que sólo interviene el 
instructor, mientras que aumenta si éste anima a los estudiantes a participar. 

La participación de los estudiantes es muy desigual : entre un 10 y un 20% de los estudiantes domina la 
discusión, haciendo preguntas y comentarios, mientras que el 80 ó 90% restante interviene sólo 
ocasionalmente o si es preguntado expresamente por el instructor. 

COMPONENTES 

Para utilizar el Sistema de Mandos Interactivos EduClic es preciso disponer de: 

Un ordenador con el Software EduClic instalado  
Un proyector de vídeo* 
Un receptor EduClic 
Mandos de Respuesta EduClic 

 

• Necesario para la cómoda visualización de la sesión  
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Atención:  Recordar incluir las pilas en los mandos (dos pilas AA, 1,5 v) 

Comprobar que el mando funciona pulsando cualquier tecla.  Se debe 
encender el led. 
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Software H-ITT 

 
Bajar el sof de Internet 
 
El software es gratuito, y se puede bajar de Internet. El sof básico consiste en dos programas: 
Acquisition (capturador de datos) y Analyzer (generador de informes)  
Acquisition permite capturar los datos de las alternativas que los alumnos respondan, mostrar 
gráficos con la información acumulada y almacenar toda esa información para ser vista con el 
programa Analyzer. 
El programa  Analyzer por su parte permite ver el “libro de clases”, generar informes, etc. 
Incluso exportarlos a archivos tipo Excel. 
 
La página oficial de H-ITT es   http://www.h-itt.com/index.html  
 
Utilizar el CD de instalación  
 
Introducir el CD.  El CD es auto ejecutable. Si no se abre automáticamente, seleccionarlo en Mi 
PC y con el botón derecho de ratón seleccionar Explorar. Abrir con doble clic el archivo 
index.htm 
Aparece una pantalla como esta: 
 

 
 
En este manual seguiremos todos los pasos para Windows XP 
 
Paso 1.  Instalar los USB Drivers:  pichar en 2000/XP/Vista Auto Installer 
 
Se instala sólo, muy rápido 
Insertar el receptor (aparato con la antena) en el puerto USB. Windows reconoce el nuevo 
hardware, lo instala, y listo. 
 
Probar con un mando que el receptor recibe señal. Se enciende el led del mando y del receptor 
 
Instalar el software H-ITT CRS, para Windows. Seguir todos los pasos aceptando las 
condiciones.  
Normalmente en el escritorio aparecen los accesos directos de las aplicaciones 
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Cómo ejecutar el software 
El software interactivo de H-ITT se compone de dos aplicaciones: Acquisition Program y 
Analyzer Program.  
 
Acquisition 
  
• Recoger las respuestas de los estudiantes en una clase 
• Mostar en la pantalla la identificación de quién responde 
• Guardar las respuestas en un archive para luego analizarlas en el Analyzer program 
• Mostrar un gráfico de barras con las respuestas en pantalla 
• Mostrar imagines en distintos formatos; PowerPoint, Word, Excel, Pdf, etc. 
 
Analyzer 
  
• Mantener un libro de clases electrónico  
• Ver puntuación acumulada y/o individual de sus alumnos 
• Generar archivos (como Excel) con los datos 
• Construir una lista de curso usando e-mail 
• Sus estudiantes podrán estar informados vía e-mail de sus resultados  
 
 
 
Cómo usar el programa Acquisition 
 
Abrir la aplicación, por ejemplo con doble clic en el icono de escritorio 
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Cómo chequear el Puerto COM del Pc - Starting Screen (pantalla de inicio) 
 
Compruebe si su receptor de datos y puerto están ok. Ello aparece bajo el título “Port and Base 
Unit Type”, si indica el nombre del Puerto (Ej. COM 12) y la descripción del capturador o 
receptor (Ej. Two Way and/or High Speed (IR)) 
Debemos seleccionar pulsando en change, la opción Radio Frecuency (RF) además de 
seleccionar el correspondiente “Baud rate”. La información se encuentra en la parte posterior 
del receptor. 
 
 

 
 
 
 
 

 
 
Comprobamos que el receptor recibe correctamente la señal de los mandos, simplemente 
pulsando cualquier tecla sobre cada uno de ellos. Si se detectan correctamente aparecen en la 
parte de la derecha 
 

 
 
 
Para usar Acquisition para capturar las respuestas de los estudiantes a las preguntas 
debemos hacer lo siguiente:  
 
1. Si el programa se ejecuta por primera vez 
 
 Haga un clic en CREATE A CLASS (Crear Clase). Si no es la primera vez, y su clase se 
encuentra en la lista, favor siga a paso 2. 
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 Ingrese la información que solicita el cuadro de diálogo,  
Class Name (Nombre de la Clase)  
Instructor Name (Nombre del Instructor).  
código del control remoto del profesor (ID Number) si desea responder también con sus 
alumnos (el Analyzer program tomará su respuesta como la correcta).  
Puede ingresar el número de alumnos que asistirán (siempre considere un 10% más de lo que 
piensa) en Class Enrolment (Inscritos en la Clase).  
indique en qué carpeta se almacenarán todos los datos de la clase (Class File Folder) (se 
recomienda crear dicha carpeta antes de crear la clase).  
Por defecto crea una carpeta en Mis documentos:  My H-ITT Files con el nombre de la clase 
Puede también ingresar una contraseña para proteger su clase.  
 
 

 
 
Finalmente haga clic en OK para crear la clase, esta aparecerá en la lista de clases. 
 

 
 
 
2. Haga Clic en el nombre de su clase para iniciarla.  
Cada vez que usted inicie una clase se crea automáticamente un nuevo archivo en la carpeta 
que definió para guardar los datos de cada clase. Las respuestas de todas las preguntas de 
esa clase son grabadas automáticamente en ese archivo y carpeta, de manera que no tendrá 
que preocuparse de respaldar las respuestas, pues siempre serán almacenadas.  
El nombre de ese archivo está compuesto por el nombre de la clase, fecha y hora (Ej. 
Clase1_10_22_2006_13_45). Al iniciar la clase, se presentará una pantalla negra con una 
barra de tareas arriba  
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3. Presente una consulta a la audiencia (con alternativas) y presione el botón verde en la barra 
de tareas.  
 
Por ejemplo: 
Pregunta 1  ¿Conocíais el sistema de mandos? 
Respuestas     A) Si, muy bien 
  B) Sí, pero muy ligeramente 
  C) Algo he oído, pero no lo conocía 
  D) No conocía nada 
  E) No contesto 
 
4. Haga que los estudiantes respondan presionando la alternativa escogida en sus controles 
remotos.  
Un cuadro de color aparecerá en la pantalla por cada estudiante indicando que su respuesta ha 
sido capturada. 
 Adicionalmente, la luz en el control remoto de cada uno, se tornará verde al ser recibida su 
respuesta.  
En este ejemplo contestan cuatro mandos.  El nº 110 corresponde al del profesor, y su 
respuesta se considerará la correcta (en este ejemplo, la B) 
 

 
 
5. Cuando usted desee detener la consulta, presione el botón rojo en la barra de tareas y el 
gráfico de barras con las respuestas tabuladas aparecerá.  
Observamos que la respuesta dada por el profesor no aparece contabilizada en el gráfico de 
barras. 
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6. Puede repetir los tres pasos anteriores cuántas veces lo desee.  
 
Pregunta 2  ¿Tenéis intención de utilizarlo en clase? 
Respuestas     A) Siempre 
  B) Ocasionalmente 
  C) Con mucha frecuencia 
  D) No 
  E) Lo decidiré después 
 
En este ejemplo contestan cuatro mandos.  El nº 110 corresponde al del profesor, y su 
respuesta se considerará la correcta (en este ejemplo, la C) 
 

 
 

 
 
7. Salga del programa o presione la flecha azul para retornar a la lista de clases.  

  
 
 
Podemos ver los archivos de respuestas generados pinchando directamente sobre la carpeta 
 

 
 
Observar cómo el nombre de ese archivo está compuesto por el nombre de la clase, fecha y 
hora. Además está comprimido 
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Para ver el Libro de Clases, y generar informes, usted deberá ejecutar el Analyzer program.  
 
Si ejecuta Analyzer en otro ordenador, necesitará copiar los archivos de la clase en él. Para 
hacer esto, haga clic en el icono de carpeta a la izquierda del nombre de su clase, y copie el o 
los archivos que desee.  
Hay muchas maneras para copiar automáticamente los archivos de una clase a otro ordenador, 
por ejemplo; generando una copia adicional en otro Pc, a través de e-mail o por el servidor de 
su institución. 
Así mismo, hay muchas maneras de presentar las preguntas o los nombres de los alumnos en 
el cuadro del teclado, tomar exámenes en papel, etc. Es lo que verá en detalle a continuación. 
 
Una vista rápida de los resultados en Analyzer 
 
Abrir la aplicación, por ejemplo con doble clic en el icono de escritorio 
 

 
 
Pinchar en Add a Class o bien en el enlace para buscar la lista  
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Pinchamos sobre el curso correspondiente. Tenemos posibilidad de ver las estadísticas por 
pregunta, estudiante, etc. 
 

 
 

 
 
Podemos exportar los datos a un archivo .csv, que se puede abrir con Excel 
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En lo que sigue veremos con mayor detalle las diferentes opciones de 
configuración de una clase con Acquisition 
  
Cómo iniciar una clase - Starting Screen (pantalla de inicio) 
Para iniciar una clase, haga clic en el nombre de la misma (o en Demo Mode si quiere 
practicar). Si su clase está protegida por una contraseña, usted necesitará digitarla. Al iniciar la 
clase, se presentará una pantalla negra con una barra de tareas arriba 
 
Cómo ejecutar el modo de práctica (demo mode) - Starting Screen 
(pantalla de inicio) 
Para practicar o probar el software usted puede usar el Demo Mode (no necesita crear una 
clase). Para hacerlo solo debe hacer clic en DEMO MODE en la pantalla de inicio. Se 
presentará una pantalla negra con una barra de tareas arriba. 
 

 
 
Cómo usar el control remoto del instructor – Menú, Options, General 
En la barra de tareas, escoja el menú Options, luego la etiqueta General, observe el cuadro 
Instructor Remote ID Number y digite el número de su control remoto tal cual aparece en el (por 
lo general son 6 dígitos), acepte con OK. El primer beneficio de esto es que sus respuestas 
serán consideradas como las correctas para el Analyzer Program, también podrá mostrar en el 
gráfico de barras (con una barra verde) la respuesta correcta y compararla con las de los 
estudiantes (sólo si hay alguno de ellos que ha contestado correctamente). Hay que pinchar en 
el botón situado en la parte superior. 
 

                        
 

Usando el teclado para ingresar las respuestas del instructor 
Es posible ingresar las respuestas del instructor utilizando el teclado del Pc. Para hacerlo 
compruebe que el teclado esté habilitado en Options>General>Enable Instructor Keyboard 
Input (habilitar con clic). Luego ingrese cualquier número de 6 dígitos en Instructor Remote ID 
acepte con OK. Si el instructor no tiene su control remoto, puede controlar el programa desde 
el teclado e indicar la respuesta correcta desde el teclado con mucha simpleza. En adición a 
las teclas A a E o 1 a 0 (para las alternativas de respuestas) 
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 Teclas  
A, a, o 1  
B, b, o 2  
C, c, o 3  
D, d, o 4  
E, e, o 5  
F, f, o 6  
G, g, o 7  
H, h, o 8  
I, i, o 9  
J, j, o 0  
 
También hay otras tres teclas que permiten hacer más cosas durante la captura o consulta.  
 
R, o r Tabulará como todas correctas  
I, o i Ignorará la pregunta  
N, o n Tabulará como todas incorrectas  
 

Controlando el software con el control remoto del instructor.  
El control remoto del instructor puede controlar el software desde cualquier lugar de la sala de 
clases. Para habilitarlo compruebe en Options>General>Enable Instructor Remote Control 
(habilitar con clic verde). Esta modalidad opera en el modo de preguntas comunes y no en 
modo de toma de examen con papel (Testing Mode).  
 

 
 
Los comandos que se pueden usar dependerán en qué proceso del programa se encuentra. A 
continuación una lista de comandos dependiendo del proceso en que se encuentra. 
Mientras el programa se encuentra en espera de consulta:  
‘>>’- inicia consulta (punto verde en barra de tareas se torna rojo).  
‘A’ – Aumenta el tiempo.  
‘B’ – Disminuye el tiempo.  
‘C’ – Imagen siguiente.  
‘D’ – Imagen anterior.  
‘E’ – Finaliza la clase (exit).  
Mientras el programa está en captura de respuestas:  
‘>>’- termina consulta punto rojo en barra de tareas se torna verde y gráfico aparece).  
‘A - J’ alternativa de respuesta del instructor normal.  
Mientras se encuentra desplegado el gráfico:  
‘>>’- borra el gráfico y retorna estado de espera de consulta.  
 
 

Cómo crear un respaldo extra de archivos de la clase - Options, General 
En el programa Acquisition en el menú Options, seleccione la pestaña General.  
Al medio de la ventana de esa pestaña hay una zona titulada “Class Files-………”). Con el 
Browse del “Secondary Folder to save…” usted podrá definir una carpeta en dónde hará un 
segundo respaldo, si está en red, puede incluso indicar otro ordenador.  
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Cómo generar un archivo en formato .CSV - Options, General  
En el programa Acquisition en el menú Options, seleccione la pestaña General.  
Marque el cuadro de ‘Also save as CVS format (.CSV)’, de esta manera usted de li dice al 
programa que genere un respaldo de cada clase en la carpeta principal en formato .csv  
El formato para el archive .csv pueden ser dos:  
Ques.#,ID,Key,Time (NºPregunta, Cód Control Remoto, Respuesta, Tiempo)  
ID,Key,Time        (Cód Control Remoto, Respuesta, Tiempo) 
Por ejemplo  
2,238644,5,3500 (el tiempo en milisegundos)  
238644,5,3500   (el tiempo en milisegundos)  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
  
Cómo configurar el tipo de pregunta multiple alternativa, verdadero falso, 
si no, abstención (multiple choice, true false, or yes) - Options, Question  
En el programa Acquisition en el menú Options, seleccione la pestaña Question (pregunta), 
luego en Question Type (Tipo de Pregunta) selecione el tipo de pregunta que desea; Multiple 
Choice (multiple alternativa), True False (verdadero Falso) y Yes No Abstein (Si No Abstención. 
Acepte con OK.  
 

 

Pág. 15 de 25 



Cómo definir el número de alternativas de una pregunta - Options, 
Question  
En el programa Acquisition en el menú Options, seleccione la pestaña Question (pregunta), 
luego en Choices (alternativas) seleccione la cantidad de alternatives que tendrán sus 
preguntas (1-10 o A-E), dependiendo si son numéricas o letras. Acepte con Ok. 

Cómo definir el número de oportunidades para una respuesta del alumno 
- Options, Question  
En el programa Acquisition en el menú Options, seleccione la pestaña Question (pregunta), 
luego en Maximun Changes (máximo de cambios) seleccione la cantidad de cambios que 
permitirá hacer en las preguntas (1 a ilimitado). Acepte con Ok.  
 
Cómo desactivar el timer - Options, Question  
En el programa Acquisition en el menú Options, seleccione la pestaña Question (pregunta), 
luego en Use Coutdown Timer (Uso de Timer) desactívelo eliminando el clik verde. Acepte con 
OK. 
 
Para contabilizar el tiempo se ajusta directamente desde los botones de la barra de 
herramientas, aumentando o disminuyendo desde la barra de herramientas.  Se puede 
aumentar o disminuir mientras se está respondiendo con la pregunta activada. 

 
 
Los incrementos de tiempo pueden variarse en la pestaña Advanced del menú Options 

 
 
Cómo insertar una etiqueta a una pregunta o clase - Options, Question 
En el programa Acquisition en el menú Options, seleccione la pestaña Question (pregunta), 
luego a la derecha de la ventana en Class and Question Labels (Etiquetas para Clases y 
Preguntas) seleccione si pondrá o no etiquetas a las Preguntas (question) y/o a la Clase 
(Class). Never (no pone etiquetas), Stara (al inicio de la pregunta o clase) End (al finalizar la 
pregunta o clase. Esta modalidad permitirá que usted en vea las etiquetas en el programa 
Analyzer (Analizador de Datos), en la pestaña Question análisis. 
 
Cómo usar el modo de toma de examen en papel - Options, Question 
En el programa Acquisition en el menú Options, seleccione la pestaña Question (pregunta), 
luego a la derecha de la ventana en Testing Mode – Paper Based Testing (Modo de Examen 
en Papel) habilite el Testing Mode (con un clic verde), luego indique el número de preguntas 
del examen en Number of Question. Además, si lo desea puede hacer que el alumno pase a la 
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pregunta siguiente automáticamente habilitando con un clic verde Auto Advance Question 
Number. 
Esta modalidad permite que usted distribuya un examen en su clase y que los alumnos, 
puedan responder en el papel y con sus controles remotos de acuerdo a la pregunta en que se 
encuentran. Por ejemplo, el alumno A puede estar respondiendo la pregunta 10 mientras, 
simultáneamente, el Alumno B responde la pregunta 5. 
 

 
 
Cómo cambiar la localización de las identidades a mostrar en pantalla, 
desde secuencial (uno tras otro) a memorizado (mantiene su posición) - 
Options, ID Display  
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display, en Display 
Mode seleccione Memorized (Memoria) o Sequencial In Time (uno tras otro). Con Memorized el 
cuadro que identifica al alumno aparece en el mismo lugar de la pantalla siempre, con 
Squencial In Time, el cuadro que identifica al alumno no tendrá posición fija, y aparecerá a 
medida que se reciben respuestas.  
 
Cómo modificar el número de alumnos a desplegar en pantalla - Options, 
ID Display  
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display, en Boxes per 
Screen (cajas en pantalla), usted puede indicar el máximo de alumnos que aparecerán en la 
pantalla. Si usted está utlizando el modo Memoraized en la localización, y quiere modificar el 
número de Cajas en la Pantalla, debe presionar el Botón Reset Box Position (a la derecha) 
para que surta efecto el cambio.  
 
 
Cómo cambiar el número de dígitos (caracteres) a desplegar en pantalla 
de cada control remoto - Options, ID Display  
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display, Digits to 
Display (Dígitos a Desplegar), indique la cantidad de dígitos (o caracteres) que se mostrarán de 
cada control remoto (1 a 9)  
 
 
Cómo desplegar en pantalla la respuesta de un alumno - Options, ID 
Display 
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display, a la derecha 
podrá habilitar Display Response (Muestre Respuesta) con un clic verde. Esto mostrará en la 
pantalla, cuando el alumno emite su respuesta, la alternativa que escogió.  
 
Cómo desplegar en pantalla el cambio de respuesta del alumno - Options, 
ID Display  
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display, a la derecha 
podrá habilitar Display Answer Changes (Muestre Cambio de Respuestas) con un clic verde, 
esto mostrará en la pantalla los cambios de respuestas que hace el alumno mientras emite su 
voto.  
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Cómo desplegar en pantalla el nombre de un alumno - Options, ID Display 
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display. En la sección 
inferior, Screen Names, asegúrese que la opción Display Screen Name Instead Remote ID 
(Muestre en Pantalla el Nombre en vez del Código) se encuentre habilitada con un  clic verde.  
Con el botón Browse del Roster File (Lista), busque el archivo que contiene la lista de curso y 
selecciónelo. Si no ha elaborado una Lista de Clases, debe construir un archivo en formato .csv 
o simplemente en formato de texto .txt con el formato que desee utilizar. 
Sugerimos que el identificador de estudiante sea por ejemplo el NIP 
Una vez seleccionado el archivo de la Lista de Clase, en Roster Format elija el formato del 
archivo. Esto es muy importante. 
Por ejemplo la lista puede estar como en este simple archivo de texto, txt con el primero de los 
formatos seleccionados 

 

 
 

 

Esta respuesta 
corresponde al mando 
del instructor. 
Se puede omitir 

 
En Order Boxes as in Roster File, usted le indica al programa que los nombres de los alumnos 
se desplieguen de acuerdo al Orden de  la Lista, si no lo habilita con un clic verde, el orden 
será por orden de respuesta.  
Con Secure Mode Block Remotes.. usted solo autoriza a los alumnos que se encuentran en la 
lista. 
En Field To Display (campo a mostrar) usted define cuál será el campo de la lista de curso que 
se mostrará. 
 
En el programa Analyzer se tienen los datos asignados a cada uno de los nombres de la lista, 
en diferentes vistas, por ejemplo: 
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Cómo bloquear controles remotos que no están en la lista de curso - 
Options,ID Display 
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display, en la sección 
inferior, Screen Names, enn Secure Mode Block Remotes, usted sólo autoriza a los alumnos 
que se encuentran en la lista. 
 
Cómo cambiar el color (que se muestra en pantalla) del control remoto o 
rehacer ubicaciones de los mismos en pantalla - Options, ID Display 
En el programa Acquisition en el menú Options, seleccione la pestaña ID Display, a la derecha 
con el botón Advance, podrá ingresar a la ventana que le permite modificar ciertas 
características de los controles remotos. El último dígito del código determina la característica 
de color, así por ejemplo si desea que todos los controles finalizados en el número 1 se 
muestren de color rojo con borde azul, debe hacerlo en Last Digit 1, Foreground Azul y 
Background Rojo.  
El tipo de letra se modifica en Font, el tamaño lo calculará en forma automática dependiendo 
de la cantidad de controles remotos. 
 
Cómo desplegar archivos, sitios Web, PowerPoint, etc. en pantalla - 
Options, Slides 
El Acquisition program puede cargar y mostrar láminas en los siguientes formatos:  
• PowerPoint (Windows version only)  
• Word (Windows version only)  
• Excel (Windows version only)  
• PDF (Windows version only)  
• H-ITT XML  
• Blackboard XML  
• HTML  
• Plain Text  
• Text donde cada pregunta está delimitada por ><  
• TIFF files  
• JPEG files  
• GIF files  
• PNG files  
• Cualquier página Web de Internet (Windows version only)  
 
Para cargar los archivos, En el programa Acquisition en el menú Options, seleccione la pestaña 
Slides, marque el cuadro Show Slides on a Portion of the Screnn con un clic verde (esto habilita 
para que el programa muestre el archivo que usted desea mostrar). Puede elegir una de varias 
formas de mostrar documentos;  
-Display Slides in a File (abre un archivo)debe indicar el tipo de archivo en File Format (Word, 
PPT, Excel, PDF, etc), luego ubíquelo con el botón Browse y cárguelo.  
-Display Slides in a Folder (abre una carpeta) debe indicar el tipo de archivos contenidos en 
esa carpeta (PNG, JPG, etc.), luego ubíquelo con el botón Browse y cárguelo.  
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-Display Web Page (abre una página Web), para cargar solo indique la dirección Web Adress  
 
 
Cómo crear preguntas y desplegarlas en pantalla 
El programa de H-ITT puede presentar preguntas a una audiencia en distintas formas y 
modalidades. Escoja la que mas se acomode a su forma de enseñar o a la clase que impartirá. 
En resumen están:  
• Pizarrón, Pizarra o sobre una proyección: - Simplemente escriba la pregunta en la pizarra y 
solicite la respuesta de los alumnos (presione botón verde en la barra de tareas). Este sencillo 
método es uno de los más comunes y utilizados, requiere poca preparación de la clase y 
permite modificar durante la misma o crear, espontáneamente, preguntas.  
• PowerPoint: - Diseñe una presentación en PowerPoint y cárguela en el Acquisition Program, o 
proyecte su presentación y al mismo tiempo ejecute el Acquisition Program compartiendo la 
pantalla con los dos programas (PowerPoint y Acquisition). Puede utilizar todos los formatos de 
Office.  
• Archivos Gráficos: - Diseñe preguntas en cualquier formato de archivo gráficos (JPG, JPN, 
etc.), y cárguelo en el programa o proyecte sus archivos y al mismo tiempo ejecute el 
Acquisition Program compartiendo la pantalla con los dos programas. Puede utilizar todos los 
formatos  GIF, JPG, TIFF o PNG.  
• PDF files: - Diseñe preguntas en cualquier formato de archivo PDF y cárguelo en el programa 
o proyecte sus archivos y al mismo tiempo ejecute el Acquisition Program compartiendo la 
pantalla con los dos programas.  
• WWW y HTML: - Diseñe preguntas en cualquier formato de archivo HTML o Página Web. Si 
trabaja en red, usted puede mostrar una dirección URL directamente en el Acquisition o 
proyecte sus archivos y al mismo tiempo ejecute el Acquisition Program compartiendo la 
pantalla con los dos programas.  
• Text y XML files: - Diseñe preguntas en cualquier formato de archivos planos de texto o XML 
e impórtelos al Acquisition Program  
 
Por ejemplo, si colocamos nuestras preguntas en un archivo de Word 
 
 

 
 
La ventan queda dividida en dos partes: en la superior muestra el archivo .doc con nuestras 
preguntas y en la parte inferior aparecen las respuestas de cada mando 
 
El área asignada a cada ventana puede modificarse desplazando la barra separadora 
convenientemente. 
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En el caso de que se fije un archivo PowerPoint, en la parte superior aparecen 
secuencialmente las diapositivas 
 
Si seleccionamos por ejemplo, una página Web, simplemente tenemos que escribir la dirección 
 

 
 
La página Web aparece en la parte superior de la pantalla. Aquí podríamos definir nuestras 
preguntas o utilizar alguna encuesta que ya esté en Red, por ejemplo. 
 

 
 
Cómo construir un PowerPoint, Word, Excel y exportarlo al 
programa 
Construya su presentación en PowerPoint, Word, Excel. Incluya sus preguntas en él y grábelo 
de la forma habitual. En el caso de PowerPoint, esta presentación puede incluir animaciones. 
Recuerde la carpeta donde guardó su archivo. Ejecute el Acquisition Program y recupere el 
archivo en Options>Sildes (Ver “Cómo desplegar archivos ..” para este paso). Si su PowerPoint 
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es muy largo, existen otras opciones para importarlo. Guarde su PowerPoint como diapositivas 
GIF, para ello en guardar como de PowerPoint, indique que desea hacerlo como diapositivas 
GIF. Se creará una carpeta con el nombre del archivo, dentro de ella cada diapositiva será un 
archivo de imagen. Registre la carpeta dónde almacenó los archivos. Ejecute el Acquisition 
Program y recupere el archivo en Options>Sildes (Ver “Cómo desplegar archivos ..” para este 
paso).  
 
Cómo presentar los archivos (PowerPoint, Word, Exel) 
simultáneamente con el Acquisition Program 
Una gran alternativa es que utilice ambos programas simultáneamente, esto evita que importe 
desde el Acquisition program su presentación. En Optios>Advance Kepp Window on Top of all 
Other Windows (Mantener ventana sobre todas las demás ventanas). Esto permitirá que usted 
pueda ejecutar el PowerPoint, Word, etc. como la hace siempre, y en un sector de la pantalla 
mantener el Acquisition Program. Puede “achicar” el Acquisition Program con el Mouse 
moviendo los márgenes de la ventana y colocándola dónde le parezca en la pantalla. Luego se 
podrá “mover” de uno a otro programa mientras los dos están activos. 
 
Es también muy útil utilizar las teclas para comandos de Windows.  
 Pulsar a la vez  Alt + Tabulador 
  

Cómo reemplazar un control remoto - Options, Loaner Remotes  
En caso de que durante una clase algún mando se estropee o quede inutilizado, falta de pila, 
etc., podemos reemplazarlo para poder continuar con la clase. En el programa Acquisition en el 
menú Options, seleccione la pestaña Loaner Remotes (reemplazo de controles remotos). Digite 
el código del control remoto que no funciona a un estudiante en Student Remote IDT (Código 
de Control Remoto del Estudiante), luego digite el código del control remoto que le prestará 
para clase en Loaner Remote ID (Código control remoto a prestar), finalmente con el botón Add 
confirme el cambio. Estos lo puede hacer con muchos alumnos al mismo tiempo. Para quitar el 
cambio, solo debe presionar el botón Clear All (borrar todo). Esta operación ayuda a que no se 
distorsione el libro de notas del alumno.  
 
Cómo modificar el gráfico - Options, Histogram 
En el programa Acquisition en el menú Options, seleccione la pestaña  Histogram (Gráfico).  
Use las distintas alternativas para modificar su gráfico.  
 

Cómo mostrar la respuesta correcta en el gráfico - Options, Histogram  
En el programa Acquisition en el menú Options, seleccione la pestaña  Histogram (Gráfico).  
Marque con clic verde el cuadro Always Indicate Correct Answer (siempre indique respuesta 
correcta). Para que esto opere, el instructor debe responder junto a los estudiantes con su 
control remoto habilitado y registrado en Options>General.  
 
Cómo enviar por e-mail o FTP los archivos de la clase - Options, E-mail y 
FTP 
En el programa Acquisition en el menú Options, seleccione la pestaña E-mail o la pestaña FTP, 
respectivamente. Ingrese allí la información requerida sobre, mail dónde enviará la información 
Email class file to the following email adress (email dónde enviará la información al finalizar su 
clase), su dirección de email en Your Email, su nombre en Your Name, y servidor, usuario y 
password, compruebe que la conexión está correcta con el botón Send Test Message (envío 
de mensaje de prueba). Se enviará un e-mail automáticamente al finalizar cada una de sus 
clases. Si su servidor requiere encriptar los archivos, marque con un clic verde en These Server 
requires encripted conection.  
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Una vez que finalizamos la clase la aplicación nos manda el mensaje con copia de las 
respuestas. 
Esta es una buena medida si la clase se realiza en un ordenador de aula, de modo que 
siempre podemos mandarnos copia de seguridad a nuestro propio correo. 
 

 
 
Del mismo modo en la pestaña FTP deberemos de poner los datos de nuestro servidor. 
 
En ambos casos es conveniente guardar también una copia en local de todos los archivos, por 
si la conexión por Red falla (caída inesperada, fallo en la luz,...). Esto se realiza en la pestaña 
General del menú Options como ya hemos explicado antes. 
 

Cómo bloquear la presentación automática del gráfico - Options,advanced 
En el programa Acquisition en el menú Options, seleccione la pestaña Advanced.  
Elimine con un clic la verificación en verde en Automatically display graph (despliega 
automáticamente el gráfico).  

Cómo grabar los datos del gráfico en un archivo - Options, Advanced  
En el programa Acquisition en el menú Options, seleccione la pestaña Advanced.  
Seleccione la opción Put Place Histogram Data on clipboard when question is finished, en ese 
caso, al finalizar la pregunta usted puede pegar los datos del gráfico (no la imagen) a cualquier 
archivo de texto abierto.  
Si se desea pegar la imagen del gráfico o las respuestas, utilizar las correspondientes opciones 
del menú File de la barra de tareas. 

 
 
Cómo hacer que el programa avise al instructor para que grabe o no la 
clase - Options, Advanced 
En el programa Acquisition en el menú Options, seleccione la pestaña Advanced.  
Seleccione la caja etiquetada como  Prompt to save response data alter each question . 
Al finalizar cada pregunta pedirá confirmación para guardar. 
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Cómo cambiar la contraseña - Options, Advanced 
En el programa Acquisition en el menú Options, seleccione la pestaña Advanced. Haga clic en 
el botón Change Password (cambiar password) y cámbiela.  
 
 
Cómo usar el modo de teclado para practicar con el programa - Options, 
Advanced 
Para simular una clase con captura de datos y tabulación usando el teclado; en el programa 
Acquisition en el menú Options, seleccione la pestaña Advanced y modifique la fuente de 
entrada de datos Input Source indicando Keyboard. Acepte los avisos que aparecerán.  
Ahora, haga clic en el círculo verde para iniciar la captura de datos, notará que el timer 
comienza a correr, presione cualquier letra A-E o 1-0 de su teclado y las respuestas 
comenzarán a aparecer en su pantalla. Los números al interior de cada cajita representa un 
código de teclado de sus estudiantes virtuales. Haga clic en el círculo rojo y detendrá la 
consulta, apareciendo automáticamente un gráfico con las respuestas.  
  
Cómo exportar a un archivo de imagen la identificación del teclado o los 
gráficos presentados en la pantalla. 
Los cuadraditos que identifican al alumno y los gráficos que se despliegan en la pantalla 
pueden ser exportados a archivos de imagen del tipo TIFF, PNG, JPEG. Esta modalidad es 
sólo para utilidad personal y no para tabular los datos, pues esto son tabulados 
automáticamente y grabados.  
Para exportarlos como un mapa de bits (imagen): 
1. que todos los estudiantes voten.  
2. detenga la consulta haciendo clic en el círculo rojo  
3. seleccione en la barra de tareas File->Export ID Box display (archive exportar identificación 
de alumno) o File->Export histogram (archivo exportar gráfico).  
4. Aparecerá una ventana de windows en donde usted podrá seleccionar el tipo de archive 
(TIFF, PNG, JPEG) y guardarlo con el nombre que desee en la carpeta que desee. 
5. haga clic en guardar para guardar el archivo.  

 
 
Cómo mantener en una ventana independiente el Acquisition Program 
La ventana del Acquisition program puede posicionarse por sobre todas las otras ventanas de 
Windows. Esto es conveniente si quiere ejecutar un PowerPoint (u otra aplicación office) y el 
Acquisition program simultáneamente.  
1. después de iniciar su clase, defina el tamaño de la venta del Acquisition al tamaño que 
desea (utilice el mouse)  
2. En Options>Advance seleccione la opción Keep Window on Top all other windows y  haga 
clic en OK.  
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____________________________________________________ 

 
 
Parte de este material está basado en los siguientes documentos, de los que 
se toman textos explicativos que han de considerarse como citas:  

 
• The H-ITT Classroom Response System 
Transmitters, receivers, and computer software for an inter-active classroom, 
Edition 1.9, June 2006, de Hyper-Interactive Teaching Technology (H-ITT) 
 
• Manual de usuario de programa Acquisition (capturador de datos) para uso con 

sistema de respuesta personal (PRS) de H-ITT, de  Baltec Chile Representante 
Oficial de H-ITT 

 
Todas las imágenes son originales, aportadas por Ana Allueva. 
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